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Special Considerations

• When using a customer's PC, the client may be worried about information leaks or data corruption,
so care must be taken to reduce such fears. Before performing operations, it may be best to ask the
customer to sign a memorandum of understanding (such as a Non-disclosure agreement or a
waiver of liability).

• If the service representative is using their PC or a USB device to attach a customer's PC, care should
be taken to not introduce a virus or other malware into the customer's network.
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Glossary
Term Description

Activation
To make a request for a license for software to the Activation Server. In
Remote Install Manager, activation is part of installation.

Deactivation
To return an acquired license to the server. In Remote Install Manager,
deactivation is part of uninstallation.

eDC-i

This is the name of the entire system which has the following roles:

• SDK software product delivery

• Product key and license file delivery

• Product activation authorization

• License management on database.

Embedded Software
Combination Table

To check the following:

• Version compatibility of Java VM and system firmware

• Supported combination of SDK applications

• Necessary Heap/Stack Size

This table can be downloaded from the Operation UI Server.

Installation
To install software on a device. In Remote Install Manager, activation is
part of installation.

Operation UI Server

This server is designed to be the primary interface for the eDC-i. All
functions needed by marketing, customer engineers, or technical
support staff can be quickly accessed by logging in to the Operation UI
Server from any web browser located on the R-WAN (some features
will eventually be available from outside the R-WAN).

RIM
This stands for Remote Install Manager which enables managing
software as well as installing or updating software to numerous
multifunctional devices.

Uninstallation
To uninstall software from a device. In Remote Install Manager,
deactivation is part of uninstallation.

Web Image Monitor
A management tool which enables checking the status of a device from
a PC (web browser).

2



TABLE OF CONTENTS
Special Considerations......................................................................................................................................1

Glossary..............................................................................................................................................................2

1. Overview

Introduction.........................................................................................................................................................7

Basic Functions of Remote Install Manager.................................................................................................7

Operating Environment..................................................................................................................................8

Limitations.....................................................................................................................................................10

Screen and Menu Description........................................................................................................................12

Workflow......................................................................................................................................................12

Quick Installation Screen............................................................................................................................12

Device List Screen........................................................................................................................................14

Product Key List Screen...............................................................................................................................32

Basic Functions of Remote Install Manager...................................................................................................41

System Outline of Remote Install Manager...............................................................................................41

Work State Archive File...............................................................................................................................44

Importance of Deactivation.............................................................................................................................45

Overview of eDC-i system and Remote Install Manager..............................................................................46

Case 1: Online Environment.......................................................................................................................46

Case 2: Offline Environment.......................................................................................................................46

Online Environment: Installation/Activation..............................................................................................48

Online Environment: License Update.........................................................................................................49

Online Environment: Software Update......................................................................................................50

Online Environment: Uninstallation/Deactivation.....................................................................................51

Offline Environment: Installation/Activation (2 visit-course)....................................................................52

Offline Environment: License Update.........................................................................................................53

Offline Environment: Software Update......................................................................................................54

Offline Environment: Uninstallation/Deactivation....................................................................................55

2. Preparation

Prior Confirmation............................................................................................................................................57

Environmental Check...................................................................................................................................57

Product Key(s) and Device List/ Work Archive File..................................................................................58

Java VM Version Check..............................................................................................................................59

Type-C Application Check..........................................................................................................................60

3



Device Authentication..................................................................................................................................60

3. Installation/Activation

Launching Remote Install Manager................................................................................................................61

Online: Installation/Activation........................................................................................................................63

Important Notices........................................................................................................................................63

Work Flow....................................................................................................................................................64

Installation/Activation Procedure...............................................................................................................65

Offline: Installation/Activation........................................................................................................................72

Important Notices........................................................................................................................................72

2-visit Course................................................................................................................................................72

4. Updating Licenses

Online: Updating Licenses...............................................................................................................................83

Work Flow....................................................................................................................................................83

Update Licenses Procedure.........................................................................................................................83

Offline: Updating Licenses...............................................................................................................................90

Work Flow....................................................................................................................................................90

Update License Procedure..........................................................................................................................91

5. Updating Software

Online: Updating Software.............................................................................................................................99

Work Flow....................................................................................................................................................99

Update Software Procedure.......................................................................................................................99

Offline: Updating Software...........................................................................................................................105

Work Flow.................................................................................................................................................105

Update Software Procedure.....................................................................................................................105

6. Uninstallation/Deactivation

Online: Uninstallation/Deactivation............................................................................................................109

Important Notices......................................................................................................................................109

Work Flow.................................................................................................................................................109

Uninstallation/Deactivation Procedure...................................................................................................110

Offline: Uninstallation/Deactivation............................................................................................................114

Work Flow.................................................................................................................................................115

Uninstallation/Deactivation Procedure...................................................................................................116

4



7. Other Operations

Offline Operations.........................................................................................................................................121

Update Java VM.......................................................................................................................................121

Change Heap/Stack Size........................................................................................................................124

8. Troubleshooting

Troubleshooting Guide..................................................................................................................................127

Error Code List...........................................................................................................................................127

5



6



1. Overview

Introduction

Basic Functions of Remote Install Manager

Remote Install Manager is an application which enables managing software as well as installing or
updating software to numerous multifunctional devices (referred to as "device" hereafter). The following
are the main basic functions.

Installation

New software for which a product key has been purchased can be installed and activated on target
devices.

For details, refer to p.61 "Installation/Activation".

Update License

Licenses can be updated to convert Trial Version Licenses to Official Licenses.

For details, refer to p.83 "Updating Licenses".

Update Software

When updated software for software installed in a device released on the Component Server, it can be
downloaded to update the software.

For details, refer to p.99 "Updating Software".

Uninstallation

When the deactivation of software is necessary due to the replacement of a device or the termination of
a contract, software can be deactivated and uninstalled.

For details, refer to p.109 "Uninstallation/Deactivation".

Updating Java VM

The eDC-i on which the function of Remote Install Manager can be operated can update the Java VM in
conjunction with a software update as a simple batch operation.

For details, refer to p.121 "Update Java VM".

Change Heap/Stack Size

Changes the Heap/Stack Size for the devices (offline), in order to adjust the correct Heap/Stack size
for the software combination used in the devices.

For details, refer to p.124 "Change Heap/Stack Size".
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Operating Environment

Brief Overview of Remote Install Manager

PC

Supported Operating
Systems

Windows XP Home Edition/ Professional (32-bit) (Japanese, English
(U.K., U.S.A.))

Windows Vista Business / Enterprise / Ultimate (32-bit) (Japanese,
English (U.K., U.S.A.))

Windows 7 Professional / Enterprise / Ultimate (32-bit) (Japanese,
English (U.K., U.S.A.))

CPU Intel Pentium4 2.80 GHz or higher (recommended)

Memory 1 GB or higher (recommended)

Monitor
XGA (1024×768 pixels) or higher, High Color (65536 colors) or
higher

1. Overview
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Hard Disk Space

Program Area: 20 MB

Log Files: Several MB

Software Size: Depending on components

Supported Browsers Browsers which support WIM (Web Image Monitor)

Internet Connection An internet connection must be available

External Systems

Devices

Remote Install Manager supports 07A or later devices.

Server

• Component Server

• Activation Server

Java VM Version

The Remote Install Manager can update the Java VM in conjunction with a software update as a simple
batch operation. However, if the Java VM is a version not supported by the RIM (Remote Install
Manager) system, the JavaVM must be updated to a supported version manually before the batch
update function can be used.

To use this functionality, the versions of Java VM shown in the following table are required.

Online

Devices Java VM

07A/08S models V4.24 or later

08A models V5.13 or later

09S models V6.08 or later

09A models V7.13 or later

Extended 09A models V7.13 or later

Offline

Devices Java VM

07A/08S models V4.21 or later

Introduction
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Devices Java VM

08A models V5.10 or later

09S models V6.05 or later

09A models V7.06 or later

Extended 09A models V7.06 or later

• If the Java VM is older than the version shown in the offline table above, Remote Install Manager
will fail to detect the version of Java VM installed on the device.

• If an offline-supported but not online-supported Java VM version is installed, an error will occur
when attempting to update it using the online method.

• To update the Java VM from an older, unsupported version, use the Version Up Tool.

Network

A network environment with the following protocols and port numbers is required for communication
with external systems.

Communication with the Device

Protocol Port Number

HTTP/HTTPS 80/443 (used when displaying properties)

HTTPS 51443 (used in all other cases)

Communication with Server

Protocol Port Number

HTTPS 443

Limitations

The maximum number of devices/product keys

• The maximum number of devices

1. Overview
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The maximum number of devices is limited to 100: Up to 100 devices can be added to the list. If
you attempt to add more devices, you will get an error message.

• The maximum number of product keys

The maximum number of product keys is limited to 100: Up to 100 product keys can be added to the
list. If you attempt to add more product keys, you will get an error message.

Introduction
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Screen and Menu Description

Workflow

The following is the workflow (screen transition) for Remote Install Manager and the basic functions that
can be operated from each screen.

Quick Installation Screen

This screen is used to execute the procedure of Installation, Update License or Others in a series of steps.

1. Overview
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The following operations are available from the Quick Installation screen.

[Installation]

Installs new software for which a product key has been purchased on target devices.

For details, refer to p.63 "Online: Installation/Activation".

[Update License]

Updates licenses to convert Trial Version Licenses to Official Licenses.

For details, refer to p.83 "Online: Updating Licenses".

[Other]

Switches to the List screen and enables checking the status of the devices and product keys. Update
Software and uninstallation of software are performed from the List screen.

• Clicking [Exit] is the same as clicking [Other].
To re-display the Quick Installation screen, select [Quick Installation Screen] in the [View] menu.

• The Quick Installation screen will not appear when the work state archive (*.clz) contains one or
more devices on which error re-execution is required.

• To re-display the Quick Installation screen, do either of the following:

• - Clear the error on each device.

• - Select [New] in the [File] menu after saving the work state archive (*.clz).

Screen and Menu Description
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Device List Screen

This screen is used to manage, add, and check devices.

(1) Menu Bar

Various operations are available from the [File] menu, [Device Operation] menu, [View] menu and
[Help] menu. For details, refer to the description of each menu.

(2) Tool Bar

Click the following icons to execute the corresponding functions.

Function Description

Install Same as [Install] of the [Device Operation] menu.

Update License Same as [Update License] of the [Device Operation] menu.

Update Software Same as [Update Software] of the [Device Operation] menu.

Refresh All Items Same as [Refresh All Items] of the [View] menu.

Refresh Selected Items Same as [Refresh Selected Items] of the [View] menu.

Quick Installation Screen Same as [Quick Installation Screen] of the [View] menu.

(3) Tree View

The screen can be switched between the Device List and Product Key List screens.

1. Overview
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(4) Header

A list of purchased software appears in the [Select Product] combo box. When a software program is
selected, the installation status appears in [Software Status] of the List View.

(5) List View

A list of registered devices appears.

Column Description

Address Device IP address or host name

Machine ID Machine ID (serial number) of the device

Model Name Name of the device model

Location Device installation location obtained from the device

Software Ver. Installation version of selected software in the Select Program.

Last Operation Status of the last operation

Operation Result Result of the last executed operation

Re-execute Error Status of the re-execution

Java VM Ver. Installation version of the Java VM

Heap Size Heap size of software installed in the device

Stack Size Stack size of software installed in the device

Last Communication Date Date and time of the last communication made with the device

• If the installation status cannot be retrieved, " " appears for [Software Status].

• The contents displayed in [Operation Results] are as follows.

[Operation
Results]

Description

Processing
The device or server is still processing your request. Select [Refresh All Items] or
[Refresh Selected Items] in the [View] menu to update the information.

Off-line
Processing

The offline process is not completed yet.

Screen and Menu Description
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Error
An error has occurred. Details of the error and ways to correct it can be checked in
[Display Results] of the [Device Operation] menu.

Warning Processing to the device is terminated due to a warning error.

Unprocessed Your request was not processed.

Completed The process was completed successfully.

“ ” Process information was not retrieved. (Immediately after software installation)

[File] Menu

[New]

Creates a new work state archive for the device list and product key list.

1. In the [File] menu, select [New].

• A confirmation screen appears asking whether to save the file currently being viewed.

2. Select [Yes] or [No].

• When saving a new file, make sure to specify “.clz” as the file extension.

[Open]

1. Overview
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Opens the work state archive for the device list and product key list.

1. In the [File] menu, select [Open].

• A confirmation screen appears asking whether to save the file currently being viewed.

2. Select [Yes] or [No].

• When saving a new file, make sure to specify “.clz” as the file extension.

3. Select the file to be opened.

• Select a file with the file extension “.clz”.

4. In the [View] menu of the Device List and Product Key List screens, select [Refresh All Items] or
[Refresh Selected Items].

[Save]

Overwrites and saves the information for the file currently being used.

[Save As]

Saves the current information as a file. Information for the device list and product key list are saved as
one file.

• Make sure to specify “.clz” as the file extension.

[Environment Setting...]

Operating Environment

Configures the settings for the work folder.

1. In the [File] menu, select [Environment Setting...].

• The Environment Setting screen appears.

Screen and Menu Description
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2. Click the [Operating Environment] tab.

3. In [Execution Environment] or [Specify Folder], select [Work Folder].

• If [Execution Environment] is selected, the folder set as the execution environment for Remote
Install Manager is set as the destination (folder).

• If [Specify Folder] is selected, a destination (folder) for saving must be specified with the
[Browse...] button.

4. Select or deselect the [Delete data in the work folder when exiting.] check box.

• If you want to delete all data in the [Work Folder] when exiting Remote Install Manager,
select the check box. If you want to keep the data, deselect the check box.

5. Select a country name with the list box if the country information setting needs to be changed.

• Customer Code can be entered. If you operates in the following conditions, select [*Others...]
in [Country Name], and then enter the [Customer Code].

1) No automatic verification of supported combinations (RIM (Remote Install Manager)
system)

2) Offline environment (no-internet access)

3) Special customer having a customer code

Device Communication Setting

Sets or changes the user name and password used to access a device.

1. In the [File] menu, select [Environment Setting...].

• The Environment Setting screen appears.

1. Overview
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2. Click the [Device Communication Setting] tab.

3. Click [Authentication Settings...].

• The Authentication Settings screen appears.

Screen and Menu Description
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4. Set the user name and password, and click [OK].

• Set the user name and password used to access a device. (The user name and password must
be the same as the user name and password used in Web Image Monitor.)

Server Communication Settings

Configures the settings for the proxy server.

1. In the [File] menu, select [Environment Setting...].

• The Environment Setting screen appears.

2. Click the [Server Communication Settings] tab.

1. Overview
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3. Check the [Use proxy server on LAN] check box.

4. Click [Authentication Settings...].

• The Authentication Settings screen appears.

Screen and Menu Description
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5. Set the user name and password, and click [OK].

• Set the user name and password used to access the proxy server.

6. Click [Execute] in the “Server connection test” to check if the server connection is properly set.

• Click [OK] when the “Connected successfully.” pop-up screen appears.

• Re-configure the settings for the server communication.

[Exit]

Ends Remote Install Manager.

1. In the [File] menu, select [Exit].

• If changes were made in the Device List or Product Key List, a confirmation screen appears
asking whether to save the changes.

2. Select [Yes] or [No].

• When saving a new file, make sure to specify “.clz” as the file extension.

1. Overview
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[Device Operation] Menu

[Display Result...]

Displays the details of the error and ways to correct it when an error occurs during installation, updating
licenses or uninstalling software.

1. Select the device on which the error you want to check occurred.

2. In the [Device Operation] menu, select [Display Result].

• Details of the error and ways to correct it are displayed.

Screen and Menu Description
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[Re-execute Errored Operation]

Re-executes the installation of software, update of licenses, update of software, or uninstallation of
software, if an error occurred.

1. Select the device on which to re-execute the operation.

2. In the [Device Operation] menu, select [Re-execute Errored Operation].

The failed operation due to an error is re-executed.

[Add]

Adds device(s) to the "Device List". You can add the device using [Manual Entry] or [Specify from File].
To add multiple devices at once, select [Specify from File].

Manual Entry

1. In the [Device Operation] menu, select [Add] and then [Manual Entry].

1. Overview
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• The Manual Entry screen appears.

2. Enter the host name or IP address for the device.

3. Click [OK].

• The device is added to the List View of the Device List screen.

Specify from File

1. In the [Device Operation] menu, select [Add] and then [Specify from File].

Screen and Menu Description
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• The screen for specifying the file appears.

2. Select the file to be added.

• The following types of files can be selected:

Device list information files for Remote Install Manager

The format of information csv files is as follows.

Data Description Required

Address Device IP address or host name Required item

Machine ID Machine ID (serial number)

1. Overview
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Data Description Required

Model Name Name of the device model

Location Device installation location obtained from the device

Software Ver. Installation version of the software

Last Operation Status of the last operation

Operation Results Results of the last executed operation

Re-execute Error Status of the re-execution

JavaVM Ver. Installation version of the Java VM

Heap Size Heap size

Stack Size Stack size

Last Communication
Date

Date and time of the last communication made with
the device

Host files (the addresses or host names included in the file are added as devices)

• For details, refer to Sample_DeviceList.csv as shown below which is stored in an unzipped
folder of the RIM (Remote Install Manager) zip file.

Screen and Menu Description
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3. Click [OPEN].

• The devices are added to the List View of the Device List screen.

• If [Specify from File] is selected, all devices listed in the specified file are added. The
following descriptions are displayed for [Result].

1. Overview
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[Result] Description

Communication
error

The device is not turned on. Or, this is not the target device.

Authentication
error

An authentication error has occurred.

Added The selected device is already registered.

Non-target
device

The version of Java VM is not a supported version.

Cancelled The process was not completed because it was cancelled.

[Delete]

Deletes the selected device from the Device List.

• Multiple devices can be selected.

[Properties]

Displays the Extended Feature Info page of the specified device on the Web Image Monitor.

Screen and Menu Description
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• Web Image Monitor is a management tool which enables checking the status of a device from a
PC (web browser). You can view the Web Image Monitor, without using Remote Install Manager,
just by entering the IP address of the device as the web browser address. Consumable replacement
schedules can also be checked.

• If the Web Image Monitor is not displayed after selecting [Properties], a network setting of the
customer site does not meet the network setting requirements of the Web Image Monitor. For
details about configuring the network settings of the Web Image Monitor, see "SSL Setting for Web
Image Monitor" in the "Appendixes".

[Export]

Exports a list of information on registered devices in CSV file format.

[Installation]

Installs new software on target devices with a product key and activates the software.

For details, refer to p.63 "Online: Installation/Activation".

[Update License]

Updates licenses to convert Trial Version Licenses to Official Licenses.

For details, refer to p.83 "Online: Updating Licenses".

[Update Software]

Enables downloading and performing update for software installed in a device when updates are
released on the Component Server.

For details, refer to p.99 "Online: Updating Software".

[Offline Operations]

This menu is mainly used for customers who have no internet connection environment or domains which
are not allowed to the use automatic verification of supported combinations.

1. Overview
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1. Update Java VM...

Updates the Java VM on the devices (offline), in order to update Java VM to convert the current
version to a new version. For details, refer to p.121 "Update Java VM".

2. Change Heap/Stack Size...

Changes the Heap/Stack Size for the devices (offline), in order to adjust the proper Heap/Stack
size for the software combination used in the devices. For details, refer to p.124 "Change Heap/
Stack Size".

3. Install[2-visit course]

Installs new software on target devices with a product key at the customer site using two visits. For
details, refer to p.72 "Offline: Installation/Activation".

4. Update License

Obtains updated license files from the Activation Server (online) and updates the license on the
devices (offline), in order to update licenses to convert Trial Version Licenses to Official Licenses.
For details, refer to p.90 "Offline: Updating Licenses".

5. Update Software[Local File]...

Obtains updated software from the Component Server (online) and updates the software on the
devices (offline), in order to update software to convert current version software to new version
software. This is mainly used for a customer who has no internet connection environment. For
details, refer to p.105 "Offline: Updating Software".

Screen and Menu Description
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[View] Menu

[Refresh All Items]

Updates information for all registered devices.

[Refresh Selected Items]

Updates information for selected device(s).

• Multiple devices can be selected.

[Quick Installation Screen]

Displays the Quick Installation screen.

[Help] Menu

[Display Help]

Displays the Remote Install Manager Instruction Manual (this file).

[About]

Displays the Remote Install Manager version information.

Product Key List Screen

This screen is used to manage, add, and check product keys.

1. Overview
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(1) Menu Bar

Various operations are available from the [File] menu, [Product Key Operation] menu, [View] menu and
[Help] menu. For details, refer to the description of each menu.

(2) Tool Bar

Click the following icons to execute the corresponding functions.

Function Description

Uninstallation Same as [Uninstall] of the [Product Key Operation] menu.

Refresh All Items Same as [Refresh All Items] of the [View] menu.

Refresh Selected Items Same as [Refresh Selected Items] of the [View] menu.

Quick Installation Screen Same as [Quick Installation Screen] of the [View] menu.

(3) Tree View

The screen can be switched between the Device List and Product Key List screens.

(4) List View

A list of product keys appears.

Column Description

Product Key Product Key

Software Name Software Name

No. of License(s) Number of purchased licenses

No. of License(s) Installable Number of unused licenses that can be installed

License Type Official License (No Period Limit), Trial Version License

Valid/Invalid Status of software

Screen and Menu Description
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Last Update
Date and time the information regarding the license was last updated
(the date and time the Activation Server was last accessed)

• If the license type cannot be determined, " " appears for [License Type].

[File] Menu

Menu items are the same as the [File] menu in the Device List screen.

[Product Key Operation] Menu

[Add]

Adds product key(s) to the list. You can add the product key using [Manual Entry] or [Specify from File].
To add multiple product keys at once, select [Specify from File].

Manual Entry

1. In the [Product Key Operation] menu, select [Add] and then [Manual Entry].

• The Manual Entry screen appears.

1. Overview
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2. Enter the product key.

3. Click [OK].

• The product key is added to the List View of the Device List screen.

Specify from File

1. In the [Product Key Operation] menu, select [Add] and then [Specify from File].

• The screen for specifying the file appears.

Screen and Menu Description
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2. Select the file to be added.

• The following types of files can be selected:

Product key list information files for Remote Install Manager

The format of information csv files is as follows.

Data Description Required

Product Key Product Key Required item

Software Name Software Name

Number of License(s) Number of purchased licenses

Number of License(s)
Installable.

Number of unused licenses that can be installed

License Type
Official License (No Period Limit), Trial Version
License

Valid/Invalid Status of software

Last Update
Date and time the information regarding the
license was last updated (the date and time the
server was last accessed)

1. Overview
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• For details, refer to Sample_ProductKeyList.csv as shown below which is stored in an
unzipped folder of the RIM (Remote Install Manager) zip file.

3. Click [OPEN].

• The product keys are added to the List View of the Product key List screen.

• If [Specify from File] is selected, all product keys listed in the specified file are added.

• If an error occurs, the following screen appears.

Screen and Menu Description
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The following descriptions are displayed for [Results].

[Result] Description

Invalid The selected product key is invalid.

Added The selected product key is already registered.

4. Select the added product key(s) and then select [Refresh All Items] or [Refresh Selected Items] in the
[View] menu.

5. In Tree View, select [Device List] to display the Device List screen.

6. In the [View] menu, select [Refresh All Items] or [Refresh Selected Items].

[Delete]

Deletes the selected product key(s) from the list.

1. Overview
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• Multiple product keys can be selected.

[Export]

Exports a list of information on registered product keys in CSV file format.

[Uninstall]

Deactivates and uninstalls software when the deactivation of software is necessary due to the
replacement of a device or the termination of a contract.

For details, refer to p.109 "Online: Uninstallation/Deactivation".

[Offline Operations]

Uninstallation

Deactivates and uninstalls software from devices (offline) and returns the license file to the "Activation
Server" (online). For details, refer to p.114 "Offline: Uninstallation/Deactivation".

[View] Menu

[Refresh All Items]

Updates information for all registered product keys.

[Refresh Selected Items]

Updates information for the selected product key(s).

• Multiple product keys can be selected.

[Quick Installation Screen]

Displays the Quick Installation screen.

Screen and Menu Description
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[Help] Menu

Menu items are the same as the [Help] menu in the Device List screen.

1. Overview
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Basic Functions of Remote Install Manager

System Outline of Remote Install Manager

Remote Install Manager is a utility that helps to extend the feature of one or more devices with licensed
software products.

• Software Installation/Activation

• Update License

• Update Software

• Software Deactivation and Uninstallation

SDK*:

Basic Functions of Remote Install Manager
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• An SDK application is an application developed using the Ricoh Device SDK, based on Java
Technology. Before installing an SDK application, a Java VM card needs to be installed in the
device.

Terms List around Remote Install Manager

Item Explanation

eDC-i

(electronic distribution
and charge infrastructure)

• The name of the entire system which
has the role of:

- SDK software product delivery

- Product key and license file delivery

- Product activation authorization

- License management on database.

• Actually the Component Server (see
below) and Activation Server (see
below) are located inside the eDC-i
system.

License File

• A file that can activate a software
program (or a group of software
programs) which is already installed on
a specific device.

• This file is issued by the Activation
Server (see below).

• One license file can be used for one
software program (or one group of
software programs) on a device.

Component Server

(On the Internet)

• A server where the latest version of
SDK (Type J) application software is
stored for download.

• By an access from Remote Install
Manager with the product key, the SDK
application software stored in the
server can be downloaded to the
device.

1. Overview
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Item Explanation

Activation Server

(On the Internet)

Product key reference information is
registered and updated on this server.

• Software Name

• Vender Name

• License Type

• Expiration date

• Total number of licenses available with
the key.

• Activation Status: Licenses which are
under use (activated) are listed with the
device information (Model ID/
Machine ID (Serial Number)/
Expiration day)

This server has a role of issuing license files
when a license file request is coming from
the Remote Install Manager with a product
key and device information.

Product key Image:

Firmware Download Site

• When internet access is not possible at
the customer site, SDK software should
be downloaded from the firmware
download site before visiting the
customer site.

• In the above case, Offline operation
should be done with Remote Install
Manager. (See p.72 "Offline:
Installation/Activation")

Basic Functions of Remote Install Manager
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Functions List of Remote Install Manager

Feature Explanation

Software Installation and
Activation

This feature installs new SDK software on device(s) and makes the
software on the device(s) ready to use, by using a product key and
license file.

Update License

If the license type which is currently used on the device is “Trial
version”, then the period that the customer can use the software on
the device is limited (for example, 30 days).

This feature will convert the Trial version licenses on the devices to
Official licenses for the continuous usage of the software.

Update Software
This feature updates an SDK that is already installed and activated
on a device with a newer version of the software, if newer software is
available on the Component Server.

Software Deactivation and
Uninstallation

This feature firstly removes the license file from the device and returns
the license file to the Activation server.
Then, software uninstallation will be done.

Work State Archive File

Device list, product key list and software list can be saved in a work state archive. All the work state
archives are archived in a zip file but with the extension “*clz”.

We strongly recommend that a work state archive file (*clz) be kept in your service station. This is
because it might take much time and effort to recover information for target devices if the work state
archive file is lost.

Device list

The format is the same as those created by Remote Manager. The file name is Devicelist.csv.

Product key list

One file is created per feature as “Feature name”.txt. Each file contains its product keys, with one line
per product key.

1. Overview
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Importance of Deactivation
When using Remote Install Manager, you can perform Software Uninstallation and Deactivation by
selecting “Uninstallation”.

Unless deactivation is completely performed, you are not able to do the following:

1. The same product key cannot be re-used for

a.) software re-installation/re-activation on the same device.

b.) software installation/activation on other devices.

2. On the same device (with the same machine ID (serial number)), the same product cannot be
activated, even when preparing another unused product key. (Additional activation for the same
product with a new product key will be refused by the Activation Server.)

< Device Status of Database on the Activation Server >

Before deactivation

• Status column: Activated

After deactivation is completed (= license file is returned to the Activation Server.)

• Status column: Not in use / Deactivated

A product key whose column is “Not in use / Deactivated” can be re-used for the next activation.

Importance of Deactivation
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Overview of eDC-i system and Remote Install
Manager
What you can do with the eDC-i system and Remote Install Manager, or the actual operation you must
perform will differ depending on the internet access environment at the customer site.

Firstly check if your customer site environment is Online or Offline.

Case 1: Online Environment

While Remote Install Manage on a PC is accessing a device at the customer site over a network, internet
access is also possible.

Case 2: Offline Environment

While accessing the device, internet access is not possible at the customer site.

1. Overview
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Overview of eDC-i system and Remote Install Manager
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Online Environment: Installation/Activation

Process Image of Online Environment: Installation/Activation

1. Overview
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Online Environment: License Update

Process Image of Online Environment: License Update

Overview of eDC-i system and Remote Install Manager
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Online Environment: Software Update

Process Image of Online Environment: Software Update

1. Overview
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Online Environment: Uninstallation/Deactivation

Process Image of Online Environment: Uninstallation/Deactivation

Overview of eDC-i system and Remote Install Manager
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Offline Environment: Installation/Activation (2 visit-course)

Process Image of Offline Environment: Installation/Activation (2 visit-course)

1. Overview

52

1



Offline Environment: License Update

Process Image of Offline Environment: License Update

Overview of eDC-i system and Remote Install Manager
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Offline Environment: Software Update

Process Image of Offline Environment: Software Update

1. Overview
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Offline Environment: Uninstallation/Deactivation

Process Image of Offline Environment: Uninstallation/Deactivation

Overview of eDC-i system and Remote Install Manager
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1. Overview
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2. Preparation

Prior Confirmation

Environmental Check

Online/Offline

Check if the internet connection is available or not at the customer site.

• If the customer does not allow internet connection, the field technician will have to preliminarily
download necessary software packages from the Firmware Download Site.

• Using multiple network interfaces is NOT supported by Remote Install Manager. This means
that both the access to devices and internet connection must be achieved using a network
interface.

There is a “2-visit course” for Offline installation.
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In the case of the Online configuration with the automatic verification of supported combinations
disabled or the Offline configuration, download the Embedded Software Combination Table from the
Operation UI Server to check the following:

• Version compatibility of Java VM and system F/W

• Supported combination of SDK applications

• Necessary Heap/Stack size

Country Name

[Country Name] is required for the operation of Remote Install Manager. Ask your sales staff for the
correct customer country (domain) before visiting a customer site.

Product Key(s) and Device List/ Work Archive File

Ask the customer to prepare a product key list (CSV file) and a device list (CSV file), or a Work Archive
file (CLZ file).

2. Preparation
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• [A]: Product Key List

• [B]: Device List

A sample product key list and device list are stored in a unzipped folder of the Remote Install Manager
zip file as shown below.

• When a software update or uninstallation is performed, using the Work Archive File is strongly
recommended because it contains all the necessary information about all previous operations.

Java VM Version Check

Check if the online-supported Java VM version is installed.

Prior Confirmation
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• If an offline-supported but not online-supported Java VM version (e.g. V4.21-23) is installed, the
online-supported version of the Java VM package for the Offline environment must be prepared.

• If a not offline-supported Java VM version (e.g. V4.20 or earlier) is installed, the online-supported
version of Java VM Version-up Tool must be prepared.

Java VM must be updated manually to the online-supported version using the following method.

• The Java VM module (*.ifu) will be obtained from the Firmware Download Site.

Type-C Application Check

Check if an SDK application that contains a Type-C module (i.e. modules developed using C++) is going
to be installed/updated/uninstalled.

• ELP-NX includes a Type-C module (FR Filter).

• This kind of application requires additional operations on the MFP/LP operation panel in order to
move the Type-C module stored on the VM card to the target machine’s HDD.

• Therefore, in cases where the target MFP/LP is installed in a remote location, it is necessary to have
a person on-site who is capable of moving the module at the operation panel.

Device Authentication

Ask the customer if all the target devices have the same login user name and password.

• If the device’s user name or password differs from that of Remote Install Manager, software
installation/update/uninstallation will be skipped.

2. Preparation
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3. Installation/Activation

Launching Remote Install Manager

• Do not execute Remote Install Manager in a folder which is encrypted. Otherwise, Remote Install
Manager will not work properly.

1. Download Remote Install Manager.

2. Extract the downloaded file to a folder.

• Do not extract the downloaded file to a folder which is encrypted.

3. Double-click the RemoteInstallManager.exe icon.

• Remote Install Manager is launched and the Environment Setting screen appears.

4. The Environment Setting screen appears the first time that you launch Remote Install Manager.

• Configure the settings for [Operating Environment], [Device Communication Setting] or
[Server Communication Setting].

• Customer Code can be entered. If you want to use Customer Code, select [*Others...] in
[Country Name], and then enter the [Customer Code].

• [Country Name] is required for Remote Install Manager. Ask your sales staff for the correct
customer country (domain) before visiting a customer site.
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5. Click [OK] after completing the settings for Environment Setting.

• From the second time on, you only need to perform step 3 to launch Remote Install Manager.

3. Installation/Activation
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Online: Installation/Activation
Purpose:

• Install new SDK application software on a device and make the software on the device ready for
use (= activate the software with license information).

• With a volume license product key, it is possible to install and activate SDK application software on
multiple devices at once.

Important Notices

About Network Environment and Server Operation

The eDC-i can optimize the Java VM version and adjust the correct Heap/Stack size for a combination
of several SDK software items automatically when the automatic verification of supported combinations
is turned on. However, a correct Java VM version and Heap/Stack size for software to be installed
have to be checked by a field technician if the automatic verification of supported combinations of eDC-i
is not turned on or a customer site does not have internet access. Follow the one of two actions below;

• Download the Embedded Software Combination Table from the Operation UI Server.

• Consult with your sales staff about a correct Java VM version and Heap/Stack size for software to
be installed before visiting a customer site.

About SDK Software Type

Remote Install Manager can complete the installation and uninstallation only for Type J software. If
software to be installed has mixed type software (type C and J), Type C software has to be installed
from the operation panel of the target machine. Check if software to be installed includes Type C
software.

About Operations to Multiple Devices

Operation from Remote Install Manager is effective only for devices which have the same administration
authentication settings (user name and password) as the ones in the Environment Settings of Remote
Install Manager. If some devices have different administrator authentication settings from the ones in the
Environment Settings of Remote Install Manager, operation to those devices is cancelled.

Online: Installation/Activation
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About Installation Limitations of Type C Applications

Four Type C applications or more can not be installed in a device. Make sure of this limitation when
installing SDK software package with Remote Install Manager. Installing four Type C applications in the
device can cause an installation error.

Work Flow

3. Installation/Activation
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Installation/Activation Procedure

• If the device gets damaged, replaced, or discarded, you will be UNABLE to de-activate the
product license, as the Activation Server administrator requires the machine ID (device serial
number) to forcibly de-activate the license. This will make the product key affected to the license
unusable. To avoid this situation, please ask the customer to keep a copy of the machine ID (device
serial number), and the work state archive (*clz) should be created as a part of normal Remote
Install Manager operation.

• Four or more Type C applications cannot be installed in a device. Make sure of this limitation when
installing an SDK software package with Remote Install Manager. Installing four Type C
applications in the device can cause an installation error.

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Install Manager

Online: Installation/Activation
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• Product Keys

• IP addresses and host names for target devices

• User name and password of the machine administrator account for each target devices

• Embedded Software Combination Table or information about supported software
combinations in the target machine

Action:

• Check if the VM Card (Java VM) is installed in the target devices and the version of the VM
card is compatible for the use of Remote Install Manager.

If not, install the VM card in a target machine and update the VM program to a supported
program version.

• Check if the firmware (e.g. system module) of the target devices is the latest version.

If not, update the firmware.

• Check if the Network/PC/Device meets the Environmental Requirement.

If not, configure the required environment.

• Make sure that the target devices are not used by the customer during the following
operation.

2. If the Remote Install Manager system does not use the automatic verification of supported
combinations, follow the steps below:

• 1) Check if the Java VM in the target machine agrees with the online-supported version for
Remote Install Manager. (For details, see p.9 "Java VM Version".) If not, update the Java VM
in the target machine to a correct version referring to Embedded Software Combination Table
or information about supported software combinations in the target machine.

• 2) Select [Change Heap/Stack Size] in [Offlien Operations] under [Device Operation].

• 3) Change the Heap/Stack size to the correct value for the target device which you have
already checked. If no information about a correct Heap/Stack size is available, change the
Heap/Stack size to the maximum value of the target device.

3. You can perform installation from the Device List screen or the Quick Installation screen.

Installation from the Quick Installation screen:

Launch Remote Install Manager and click [Quick Installation Screen] under the [View] menu.

3. Installation/Activation
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Installation from the Device List screen:

In the [Device Operation] menu of the Device List screen, select [Install...].

4. On the [Install Software] screen, enter the product key for the software to be installed.

• To refer to a product key used previously, click [Browse Previous Value]. Select the product
key to use and click [OK].

Online: Installation/Activation
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5. Click [Next].

• Communication with the "Activation Server" begins. When communication is complete, a
confirmation screen appears.

6. Check the contents and click [Next].

7. Select the check boxes for the devices onto which to install the software.

3. Installation/Activation
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• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

• To view the Properties screen for the device, double-click the device column or select
[Properties] in the right-click menu.

• To add devices, click [Manual Entry...] or [Specify from File...] under [Adding Device(s)].
Subsequent operations are the same as [Add] of the [Device Operation] menu.

8. Click [Next].

• The downloading, installation or activation of the software starts.

Online: Installation/Activation
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9. Click [OK] after the pop-up message has been displayed.

10. When the downloading, installation or activation is complete, click [Finish].

3. Installation/Activation
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• If a result other than [Completed] is displayed in [Operation Results], right-click on the device
column and select [Display Result...] to view a description of the error and ways to correct it.

11. Double-click the target device in the Device List screen, and then check if the target software has
been installed in the target device with WIM.

Online: Installation/Activation
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Offline: Installation/Activation

Important Notices

About Network Environment and Server Operation

A correct Java VM version and Heap/Stack size for software to be installed have to be checked by a
field technician if a customer site does not have internet access. Follow one of the two actions below:

• Download the Embedded Software Combination Table from the Operation UI Server.

• Consult with your sales staff about a correct Java VM version and Heap/Stack size for software to
be installed before visiting a customer site.

About SDK Software Type

Remote Install Manager can complete the installation and uninstallation only for Type J software. If
software to be installed has mixed type software (type C and J), Type C software has to be installed
from the operation panel of the target machine. Check if software to be installed includes Type C
software.

About Operations to Multiple Devices

Operation from Remote Install Manager is effective only for devices which have the same administration
authentication settings (user name and password) as the ones in the Environment Settings of Remote
Install Manager. If some devices have different administrator authentication settings from the ones in the
Environment Settings of Remote Install Manager, operation to those devices is cancelled.

About Installation Limitations of Type C Applications

Four or more Type C applications cannot be installed in a device. Make sure of this limitation when
installing an SDK software package with Remote Install Manager. Installing four Type C applications in
the device can cause an installation error.

2-visit Course

Purpose:

• Install new SDK application software on a device and make the software on the device ready for
use (= activate the software with license information).

3. Installation/Activation
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• With a volume license product key, it is possible to install and activate SDK application software on
multiple devices at once.

Work Flow

Offline: Installation/Activation
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Installation Procedure

• If the device gets damaged, replaced, or discarded, you will be UNABLE to de-activate the
product license, as the Activation Server administrator requires the machine ID (device serial
number) to forcibly de-activate the license. This will make the product key affected to the license
unusable. To avoid this situation, please ask the customer to keep a copy of the machine ID (device
serial number), and the work state archive (*clz) should be created as a part of normal Remote
Install Manager operation.

3. Installation/Activation
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• Four or more Type C applications cannot be installed in a device. Make sure of this limitation when
installing SDK software package with Remote Install Manager. Installing four Type C applications
in the device can cause an installation error.

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Manager Installer

• A SDK application software file (*.zip) to install

• Product Keys

• IP addresses and host names for target devices

• User name and password of the machine administrator account for each target devices.

• Embedded Software Combination Table or information about supported software
combinations on the target device

Action:

• Check if the VM Card (Java VM) is installed in the target devices and the firmware version of
the VM card is compatible for the use of Remote Installer Manager.

If not, install the VM card in a target device and update the firmware to a supported program
version.

• Check if the firmware (e.g. system module) of target devices is in the latest version.

If not, update the firmware.

• Check if the Network/PC/Device meets the Environmental Requirement.

If not, configure the required environment.

• Make sure that the target devices are not used by the customer during the following
operation.

<Customer Site>

2. Check if the Java VM in the target machine agrees with the online-supported version for Remote
Install Manager. (For details, see p.9 "Java VM Version".) If not, update the Java VM in the target
machine to a correct version referring to Embedded Software Combination Table or information
about supported software combination to the target machine.

3. Launch "Remote Install Manager" at the customer site.

Offline: Installation/Activation
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4. Add a device to the "Device List" by using [Manual Entry] or [Specify from File].

5. Select the device to install a product which has been prepared.

6. Select [Change Heap/Stack Size] in [Offline Operations] under [Device Operation].

7. Change the Heap/Stack size to the correct value for the target device which you have already
checked. If no information about a correct Heap/Stack size is available, change the Heap/Stack
size to the maximum value of the target device.

8. Select [Install[2-visit course]] under [Offline Operations].

3. Installation/Activation

76

3



9. Select the product (zip file), and then click the [Open] button.

• The confirmation pop-up appears.

10. Click the [Yes] button.

• The progress indicator pop-up appears.

11. Save the work state archive (*clz).

12. Move to an online environment to get internet access.

Activation Procedure

<Internet Environment>

Offline: Installation/Activation
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1. Launch "Remote Install Manager" and open the work state archive file (*clz) which was saved at
the customer site.

2. Select [2.Get License[Internet]] in [Install[2-visit course]] under [Offline Operations].

• The Get License (Online) screen appears.

3. Enter the product key for the installed software in the device.

• The confirmation screen appears.

4. Click the [Next] button.

3. Installation/Activation

78

3



• The Select Device to Install screen appears.

5. Select the check box for the device to be activated.

• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

6. Click the [Next] button.

• Activation starts, and then the Process Completion screen appears.

7. Click the [Finish] button.

Offline: Installation/Activation
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8. Save the work state archive (*clz).

9. Move to the customer site.

<Customer Site>

10. Launch "Remote Install Manager” and open the work state archive (*clz) at the customer site.

• The "Operation Instruction Message" pop-up appears.

11. Click the [OK] button.

12. Select [3.Store License[Internet]] in [Install[2-visit course]] under [Offline Operations].

3. Installation/Activation
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• The Select Device to Install screen appears.

13. Click the [Next] button.

• Storage of the software starts, and then the Process Completion screen appears.

14. Click the [Finish] button.

Offline: Installation/Activation
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15. The Installation/Activation Warning screen appears if the software to be installed has a Type C
application.

• A Type C application has to be installed in the target device from its operation panel
manually. “Warning” is displayed in the Device List until the Type C application is properly
installed.

16. Save the work state archive (*clz), and ask the customer to keep it.

3. Installation/Activation
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4. Updating Licenses

Online: Updating Licenses
Purpose:

• Convert Trial Version Licenses to Official Licenses for the continuous usage of the software.

Work Flow

Update Licenses Procedure

• The license type can be checked in [License Type] in the Product Key List screen.

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Install Manager

• Product Keys for updating the licenses

• IP addresses and host names for target devices

• The latest Work State Archive file (*.clz) that was saved and kept at the customer site.

• User name and password of the machine administrator account for each target device.
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Action:

• Make sure that the target devices are not used by the customer during the following
operation.

2. You can update licenses from the Device List screen or the Quick Installation screen.

Updating licenses from the Quick Installation screen:

Launch Remote Install Manager and click [Update License] on the Quick Installation screen.

Updating licenses from the Device List screen:

In the [Device Operation] menu of the Device List screen, select [Update License].

4. Updating Licenses
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3. Enter the product key for the updated license.

• To refer to a product key used previously, click [Browse Previous Value]. Select the product
key to use and click the [OK] button.

Online: Updating Licenses
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4. Click the [Next] button.

• Communication with the server begins. When communication is complete, a confirmation
screen appears.

5. Check the contents and click the [Next] button.

6. Select the check boxes for the devices in which to update the licenses.

4. Updating Licenses

86

4



• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

• To view the Properties screen for the device, double-click the device column or select
[Properties] in the right-click menu.

• To add devices, click [Manual Entry] or [Specify from File] under [Adding Device(s)].
Subsequent operations are the same as [Add] in the [Device Operation] menu.

7. Click the [Next] button.

• The downloading, installation or activation of the software starts.

Online: Updating Licenses
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8. When the downloading, installation or activation is complete, click the [Finish] button.

• If a result other than [Completed] is displayed in [Status], right-click on the device column and
select [Display Result(s)] to view a description of the error and ways to correct it.

 

9. Check the target device in the Device List screen, and then check if the “License update” of the
target has been completed.

4. Updating Licenses
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Online: Updating Licenses
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Offline: Updating Licenses
Purpose:

• Convert Trial Version Licenses to Official Licenses for the continuous usage of the software.

Work Flow

4. Updating Licenses

90

4



This procedure shows how to update a Trial Version License or term license of a device in an offline
environment.

Update License Procedure

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Install Manager

• Product Keys for updating the licenses

• IP addresses and host names for target devices

• The latest Work State Archive file (*.clz) that was saved and kept at the customer site.

• User name and password of the machine administrator account for each target device.

Action:

Offline: Updating Licenses
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• Make sure that the target devices are not used by the customer during the following
operation.

<Customer Site>

2. Launch the "Remote Install Manager" and open the work state archive (*clz) at the customer site.

3. Select a device to be updated in the Device List screen.

4. In the [View] menu of the Device List, select [Refresh All Items] or [Refresh Selected Items].

5. Save a work state archive (*clz).

6. Move to an online environment to get internet access.

<Internet Environment>

7. Open the work state archive (*clz) which was saved at the customer site.

8. Select a device to be updated.

9. Select [1.Get License[Internet]] in [Update License] under [Offline Operations].

• The Update License (Offline) screen appears.

10. Enter the product key which the customer has purchased for the license update.

4. Updating Licenses
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• The confirmation screen appears.

11. Click the [Next] button.

• The Select Device to Install screen appears.

12. Select the check box for the device to be updated on which to update the license.

Offline: Updating Licenses
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• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

13. Click the [Next] button.

• Update of the license starts, and then the Process Completion screen appears.

14. Click the [Finish] button.

15. Save a work state archive (*clz).

4. Updating Licenses
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16. Move to the customer site.

<Customer Site>

17. Launch "Remote Install Manager" and open the work state archive (*clz) at the customer site.

• The operation instruction pop-up appears.

18. Click the [OK] button.

19. Select the target device in the Device List.

20. Select [2.Store License[Device]] in [Update License] under the [Offline Operations] menu.

Offline: Updating Licenses
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• The Select Device to Install screen appears.

21. Click the [Next] button.

• Update of the license starts, and then the Process Completion screen appears.

22. Click the [Finish] button.

4. Updating Licenses

96

4



23. Save a work state archive (*clz), and ask the customer to keep it.

Offline: Updating Licenses
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5. Updating Software

Online: Updating Software
Purpose at the customer site:

• Update SDK software that is already installed and activated on a device with a newer version of
the software.

• This function will work only if newer version software is stored in the Component Server.

Work Flow

Update Software Procedure

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Manager Installer

• IP addresses and host names for target devices, in which the software should be updated.
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• The latest Work State Archive file (*.clz) that was saved and kept at the customer site.

• User name and password of the machine administrator account for each target devices.

 
Action:

• Check if the firmware (e.g. system module) of target devices is the latest version.

If not, update the firmware.

• Make sure that the target devices are not used by the customer during the following
operation.

2. Launch "Remote Install Manger" and open the latest work state archive (*clz).

3. On the Device List screen, select the device on which the software to be updated is installed.

• Multiple devices can be selected.

4. In the [Device Operation] menu, select [Update Software].

5. Updating Software
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• Remote Install Manager searches for software for which updated software is available.

5. Check the contents and click the [Next] button.

• The confirmation screen appears when the search is complete.

Online: Updating Software

101

5



• The Version Consistency column for each software item indicates whether version
matching is required for it.

• If any one of the software programs requires version matching, a warning is displayed.

• If update of the device firmware (JavaVM) is required, a confirmation screen appears.

6. Click the [OK] button after a pop-up dialog for confirmation appears.

5. Updating Software
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• Update of software starts.

• When update of software is complete, the Status column indicates "Completed".

Online: Updating Software
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• Right-click on the device column and select [Display Result(s)] to view a description of the
error and ways to correct it.

7. Check the contents and click the [Finish] button.

8. Double-click the target device in the Device List screen, and then check if the target software has
been updated with WIM.

5. Updating Software
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Offline: Updating Software
Purpose:

• Update software installed in the device(s) in an offline environment.

Work Flow

This procedure shows how to update software of a device in an offline environment.

Update Software Procedure

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Install Manager

• Updated software

• IP addresses and host names for target devices

Offline: Updating Software
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• The latest Work State Archive file (*.clz) that was saved and kept at the customer site.

• User name and password of the machine administrator account for each target device.

Action:

• Make sure that the target devices are not used by the customer during the following
operation.

<Customer Site>

2. Launch "Remote Install Manager" and open the work state archive (*clz) at the customer site.

3. Select a device to be updated in the Device List screen.

• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

4. Select [Update Software[Local File]] in [Update License] under [Offline Operations].

• The file selection screen appears.

5. Select the updated software.

5. Updating Software
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• The confirmation screen appears.

6. Click the [Yes] button.

• Update of the software starts, and then the Update Software screen appears.

7. The main screen automatically returns to the Device List screen after completing software updating.

• Check if the operation result in the Device List is “Completed”.

8. Save a work state archive (*clz).

Offline: Updating Software
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6. Uninstallation/Deactivation

Online: Uninstallation/Deactivation
Purpose:

• Deactivate and uninstall SDK software from devices due to replacement of the device or
termination of the contract, etc.

• One software program can be uninstalled/deactivated from multiple devices at once.

• When executing [Uninstall...] menu with Remote Install Manager, three processes (Uninstallation/
Deactivation/ Return License) are executed sequentially at a time.

Important Notices

About Uninstallation/Deactivation

Uninstallation from the operation panel or WIM cannot be allowed because deactivation operation
must be done before uninstallation. If you do so, some special operation is required to recover the lost
volume license.

Work Flow
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Uninstallation/Deactivation Procedure

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Install Manager

• Product Keys for which the software should be uninstalled/deactivated.

• IP addresses and host names for target devices in which the software should be uninstalled/
deactivated.

• The latest Work State Archive file (*.clz) that was saved and kept at the customer site.

• User name and password of the machine administrator account for each target device.

Action:

• Make sure that the target devices are not used by the customer during the following
operation.

2. Launch the "Remote Install Manager" and open the latest work state archive file (*clz).

3. In the Product Key List screen, select the product key to be uninstalled.

• If the target product key does not appear in the Product Key List screen, add it from [Add] in
the [Product Key Operation] menu in the Product Key List screen. You can do this by manually
entering the product key from [Manual Entry] of [Add] or by importing the relevant csv file
(must be exported in advance) from [Specify from File] of [Add].

• The target device must be added to the device list beforehand. So if the target device does not
appear in the Device List screen, add it from [Add] in the [Device Operation] menu in the
Device List screen. You can do this by manually entering the host name or IP address of the
target device from [Manual Entry] of [Add] or by importing the relevant csv file (must be
exported in advance) from [Specify from File] of [Add].

4. In the [Product Key Operation] menu, select [Uninstall].

6. Uninstallation/Deactivation
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5. Select the check boxes for the devices from which to uninstall the software.

• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

6. Click the [Next] button.

• Uninstallation of the software starts.

Online: Uninstallation/Deactivation
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7. When uninstallation is complete, click the [Finish] button.

6. Uninstallation/Deactivation
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• If a result other than [Completed] is displayed in [Status], right-click on the device column and
select [Display Result] to view a description of the error and ways to correct it.

8. In the Tree View of the Product List screen, select [Device List] to display the Device List screen.

• You can check the result of the uninstallation operation in [Last Operation] and [Operation Result]
of the List View or by double-clicking the target device in the Device List screen with WIM.

Online: Uninstallation/Deactivation
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Offline: Uninstallation/Deactivation
Purpose:

• Deactivate and uninstall SDK software from devices due to replacement of the device or
termination of the contract, etc.

• One software program can be uninstalled/deactivated from multiple devices at once.

6. Uninstallation/Deactivation
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Work Flow

Offline: Uninstallation/Deactivation

115

6



Uninstallation/Deactivation Procedure

1. Prepare as follows.

Items (Confirm with the customer):

• A PC with Remote Install Manager

• Product Keys for which the software should be uninstalled/deactivated.

• IP addresses and host names for target devices in which the software should be uninstalled/
deactivated.

• The latest Work State Archive file (*.clz) that was saved and kept at the customer site.

• User name and password of the machine administrator account for each target device.

Action:

• Make sure that the target devices are not used by the customer during the following
operation.

<Customer Site>

2. Launch "Remote Install Manager" and open a work state archive (*clz).

3. Select the product key for the installed software in the target device.

4. Select [1.Deactivate&Uninstall[Device]] in [Uninstall] under [Offline Operations].

5. Select the check boxes for the devices on which to uninstall the software.

6. Uninstallation/Deactivation
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• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

6. Click the [Next] button.

• The uninstallation of the software starts.

7. When the uninstallation is complete, click the [Finish] button.

Offline: Uninstallation/Deactivation
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• If a result other than [Processing offline] is displayed in [Status], right-click on the device
column and select [Display Result(s)] to view a description of the error and ways to correct it.

8. Save a work state archive (*clz).

9. Move to an online environment to get the internet access.

<Internet Environment>

10. Launch "Remote Install Manager" and open the work state archive (*clz) at the customer site.

• The "Operation Instruction Message" pop-up appears.

11. Click the [OK] button.

12. Select [Product Key] to display the Product Key List.

6. Uninstallation/Deactivation

118

6



13. Select [2.Return License[Internet]] of [Uninstall] under [Offline Operations].

14. Select the device from which to uninstall the software.

• Multiple devices can be selected.

• Click [Select All] or [Deselect All] to select or deselect all of the devices displayed.

15. Click the [Next] button.

• Uninstallation of the software starts.

16. When uninstallation/deactivation is complete, click the [Finish] button.

Offline: Uninstallation/Deactivation
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• If a result other than [Completed] is displayed in [Operation Results], right-click on the device
column and select [Display Result(s)] to view a description of the error and ways to correct it.

17. Save a work state archive (*clz), and ask the customer to keep it.

6. Uninstallation/Deactivation
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7. Other Operations

Offline Operations
The menus under Offline Operations are mainly used for devices located in the no-internet connection
environment.

These menus are the following:

• Update Java VM

• Change Heap/Stack Size

• Install [2-visit course]

• Update License

• Update Software

Update Java VM

This menu updates the Java VM on the devices (offline), in order to update Java VM to convert the
current version to a new version.

Updating Procedure

1. Launch "Remote Install Manger" and open the latest work state archive (*clz), or add devices with
the [Add] menu under [Device Operation].

2. On the Device List screen, select the device on which the Java VM to be updated is installed.
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• If you want to refresh the Device List, select [Refresh All Items] or [Refresh Selected Items] in
the [View] menu of the Device List. The necessary time to refresh all devices differs depending
on the number of registered devices.

3. Select [Update JavaVM] of [Offline Operations] under [Device Operation].

4. Select an updated firmware file (*.ifu), and then click the [Open] button.

7. Other Operations
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• The confirmation pop-up appears.

5. Click the [Yes] button.

6. Click the [Yes] button.

7. Check if the Java VM update is completed in the Device List screen.

Offline Operations
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Change Heap/Stack Size

This menu changes the Heap/Stack size for each device if the installation or updating of software is
done in a no-internet connection (offline) environment.

Changing Heap/Stack Size Procedure

1. Launch the "Remote Install Manger" and open the latest work state archive (*clz) or add devices
with the [Add] menu under the [Device Operation].

2. On the Device List screen, select the device for which changing Heap/Stack Size is required.

• If you want to refresh the Device List, select [Refresh All Items] or [Refresh Selected Items] in
the [View] menu of the Device List. The necessary time to refresh all devices differs depending
on the number of registered devices.

3. Select [Change Heap/Stack Size] of [Offline Operations] under [Device Operation].
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4. Enter the correct value for the [Heap size] and [Stack size].

• Check the correct value for the combination of software to be installed.

• The confirmation pop-up appears.

5. Click the [Yes] button.

Offline Operations
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6. Check the Heap and Stack size of the target device in the Device List screen.
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8. Troubleshooting

Troubleshooting Guide

Error Code List

• For error codes displayed on the [Display Results] screen, follow the operations shown on the
screen for [Handling Method].

• “RIM” stands for Remote Install Manager.

Error Codes for Remote Install Manager

Error Code Descriptions Solutions

ERR-001 No response from a device
Check the device or network condition at a
customer site.

ERR-002
• Request error from RIM.

• Device error

• See p.138 "Detailed Device Error
Number List" about “Cxx” displayed
on the pop-up window.

• Ask your supervisor if “Cxx” is not
displayed on the pop-up window.

ERR-004 Error from a device Check the device status at the customer site.

ERR-006
Error with suffix [S03] from the
Activation or Component Server

Check with the server maintenance section
when the maintenance for servers is
completed.

ERR-007
No response from a device within
specified time

Check the device status at the customer site.

ERR-008

Failure or incompletion of
downloading from the Activation or
Component Server due to network
problem or insufficient memory on a
PC

Check the network condition.

Stop other applications on your PC, and
then reboot your PC and RIM.

ERR-009
Failure of name resolution to DNS
server

Check the DNS server or network
condition.
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Error Code Descriptions Solutions

ERR-010

Connection error to servers due to
following causes

• Wrong proxy settings

• Connection Interruption by
firewall software

• Connection port (443) closed

• Connection error to servers due to
network problem

• Wrong server information on “ini”
file

Do the correct countermeasure for each
cause.

ERR-043

• License file write error

• Component data file write error

• Received data error from servers

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

RTY-001 No response from a device
Check the device or network condition at
the customer site.

RTY-002
• Request error from RIM.

• Device error

• See p.138 "Detailed Device Error
Number List" about “Cxx” displayed
on the pop-up window.

• Ask your supervisor if “Cxx” is not
displayed on the pop-up window.

RTY-003
No response from a device within
specified time

Check the device status at the customer site.

RTY-004 Error from a device Check the device status at the customer site.

RTY-005
Error with suffix [S01] from the
Activation or Component Server

Check with the server maintenance section
when the maintenance for servers is
completed. (HTTP 500 error)

RTY-006
Error with suffix [S01] from the
Activation or Component Server

Check with the server maintenance section
when the maintenance for servers is
completed. (HTTP 503 error)
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Error Code Descriptions Solutions

RTY-008

• Incorrect product key information

• Incorrect data of the automatic
verification of supported
combination

Try the operation again.

If this does not solve the error, ask your
supervisor.

RTY-010
Error from the Activation or Component
Server

Check with the server maintenance section
when the maintenance for servers is
completed.

RTY-012
Failure of name resolution to DNS
server

Check the DNS server or network
condition.

RTY-013

Connection error to servers due to
following causes

• Wrong proxy settings

• Connection Interruption by
firewall software

• Connection port (443) closed

• Connection error to servers due to
network problem

• Wrong server information on “ini”
file

Do the correct countermeasure for each
cause.

RTY-014

• License file write error

• Component data file write error

• Received data error from servers

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

RTY-017 Error with suffix [S01]
Execute [Re-execute Errored Operation]
menu with RIM.

PRO-004
No response from a device within
specified time

Check if the processing to the target device
is completed by refreshing the target
device in RIM.

SRV-001

SRV-002

Internal error at creating a request
data

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

• Reboot RIM again.
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Error Code Descriptions Solutions

SRV-003
Error from the Activation or Component
Server

• Check with the server maintenance
section when the maintenance for
servers is completed.

SRV-004
Wrong user name and password of the
device administrator authentication

• Check if the user name and password
of the device administrator
authentication are correct.

• Ask your supervisor if the user name
and password are correct.

SRV-005
Error from the Activation or Component
Server

Retry the operation with RIM.

If this does not solve the error, reboot or
reinstall RIM.

SRV-007

• Write error of component data
file

• Server received data error

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

SRV-008
• Error at Product key entry

• Unexpected error from the
Retry the operation.

SRV-009
Result error of the automatic
verification of supported combinations
from the Component Server

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

If these do not solve the error, ask your
supervisor.

SRV-010
Connection error to the Activation or
Component Server

Wait for a moment, and then retry the
operation.

If this does not solve this error, check the
server condition.

SRV-012

SRV-028

Failure of name resolution to DNS
server

Check the DNS server or network
condition.

SRV-014 Error with suffix [S01]
Execute [Re-execute Errored Operation]
menu with RIM.
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Error Code Descriptions Solutions

SRV-015 Product key addition error to the
Product Key List

Check the Product Key List.

SRV-016
Software installation error at updating
software

There is no software to be updated in the
target device. Check the installed software
in the target device.

SRV-018
Product key entry error of trial license
at updating license

A trial license cannot be used for updating
license. Use a correct product key for an
updated license.

SRV-019 Error at product key entry
The product key has non-supported
characters. Enter the correct product key
with RIM.

SRV-029

Connection error to servers due to
following causes

• Wrong proxy settings

• Connection Interruption by
firewall software

• Connection port (443) closed

• Connection error to servers due to
network problem

• Wrong server information on “ini”
file

Do the correct countermeasure for each
cause.

DEV-002 Error at creating request Ask your supervisor.

DEV-003

Error from a device

• User name and password of the
target device administrator
authentication is different from
ones registered in RIM.

Enter the correct user name and password
of the target device administrator
authentication with RIM.

DEV-007 Device addition error to the Device List Check the Device List again.

DEV-009 Target device error at uninstallation
There is no target device in the Device List
which corresponds with the product key for
uninstallation.

DEV-011 Process incomplete device error Refresh incomplete devices with RIM.
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Error Code Descriptions Solutions

DEV-012
Incorrect machine ID (serial number)
error

Enter the correct machine ID (serial
number).

DEV-013
Non-supported Java VM error for
eDC-i1.2

Update the Java VM to a correct version
for eDC-i1.2.

RIM-001 RIM internal process error

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

RIM-002 RIM internal process error

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

RIM-003 Read and write restriction error

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

RIM-004 File format error
Select the correct formatted file for RIM
operation.

RIM-005 No help file error Check if RIM has a help file installed.

RIM-006 Property display error
Check if the default browser operates
correctly.

RIM-009 Device display error

100 devices have already been registered
in the Device List.

If you want to operate other devices than
the 100 in the Device List, use a new work
state archive file.

RIM-010 Product key display error

100 product keys have already been
registered in the Product Key List.

If you want to operate other product keys
than the 100 in the Product Key List, use a
new work state archive file.
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Error Code Descriptions Solutions

RIM-011 Work state archive file saving error

• Check if free space exists in HDD.

• Check if the folder where RIM has
been installed has restrictions for read
and write.

RIM-012
Wrong entry of device administrator
authentication

Enter the same password in the text boxes
for “Password” and “Confirm Password”.

RIM-013 WIM operation error
Check if the IP address (host name) of the
target device is entered with RIM.

RIM-014 Two RIM operation error
Check if two instances or RIM are
operating on the same PC.

Error Codes for Device

Error Code Descriptions Solutions

ERR-002
• Request error from RIM.

• Device error

• See p.138 "Detailed Device Error
Number List" about “Cxx” displayed
on the pop-up window.

ERR-031 404 response from a device
Java VM in the target device is not the
correct version for RIM v3.1 and eDC-i1.2.
Update the Java VM in the target device.

ERR-032 Error from a device

When using [Offline Operations] menu,
check the following:

• Heap/Stack size is correct.

• Target device is correct.

If the error occurs again after checking the
points above, ask your supervisor.

RTY-018

Trial license error

• License is already expired.

• The clock timer in the target
device is shifted more than three
days.

Adjust the clock timer in the target device.
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Error Code Descriptions Solutions

DEV-001

1. Target device is turned off.

2. Wrong IP address of the target
device

3. Network cable to the target
device is disconnected.

4. Network is blocked by firewall
software.

5. Target device is out of support by
eDC-i1.2.

1. Turn on the target device.

2. Enter the correct IP address of the
target device.

3. Connect the network cable to the
target device.

4. Check if the network port is available
as described in the Operation
Instructions.

5. Check if the target device is
supported, referring to the Operation
Instructions.

DEV-006 Error from a device Check the target device condition.

Error Codes for Component Server or Activation Server

Error Code Descriptions Solutions

ERR-005

This occurs when trying to operate
devices more than licenses which a
product key has. (Activation Server
error)

• Check the rest of the licenses and
devices to be operated.

• Buy a new product key or uninstall
and deactivate other devices.

ERR-011
Server internal process error from the
Activation or Component Server

Check the Activation or Component Server
condition.

ERR-012 Error from the Activation Server Check the start date for license updating.

ERR-013 Error from the Activation Server

• Check the entered product key with
RIM.

• Check if the installed software in the
target device is a trial license.

ERR-014

Error from the Activation Server

• License re-issue is executed more
than 100 times. This is an
acceptable operation.

Try to install again after deactivation with
RIM or forced deactivation by an operator
of the Operation UI Server.

ERR-015 Error from the Activation Server Check the expiration date of the license.
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Error Code Descriptions Solutions

ERR-016 Error from the Activation Server

A trial license cannot be installed twice.
Check the entered product key with RIM.

Buy a new product key for an updated
license.

ERR-018 Error from the Component Server
Check the compatibility between software
to be installed and the software installed in
the target device.

ERR-020 Error from the Component Server No problem

ERR-021

Error from the Component Server • Selected software or Java VM to be
updated may not be uploaded to the
Component Server.

• Check if the selected country code in
RIM is correct.

ERR-022

Error from the Component Server Check the software installed in the target
device. Install necessary software if
supported combinations of SDK
applications are not installed in the target
device.

ERR-024

Error from the Component Server Check the software to be installed in the
target device. The special modified
software may already be installed in the
target device.

ERR-026

Error from the Activation Server

• Entered product key is not issued
by the Activation Server.

Check the product key, and then re-enter
the product key with RIM.

ERR-027

Error from the Activation Server

• Entered product key is invalided
by the Activation Server.

Check the entered product key status by
referring to the Operation UI Server.

Use another product key.

ERR-028 Error from the Activation Server Ask your supervisor.
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Error Code Descriptions Solutions

ERR-029

Error from the Activation Server • Use the product key which was used
in the previous operation, and then try
to operate again.

• To update a trial license, buy a new
product key for an updated license.

ERR-030
Error from the Activation Server Check the machine ID (serial number) of

the target device.

ERR-033
Supported combination error of SDK
applications

• Check the compatibility between
software to be installed and the
software installed in the target device.

• Ask your supervisor to correct the
Embedded Software Combination
Table and upload it to the Operation
UI Server if the compatibility among
SDK software items is approved.

• Check if the selected country code in
RIM is correct.

ERR-034
System firmware error for supported
combination of SDK applications

Update to the correct system firmware
version in the target device for supported
combinations of SDK applications.

ERR-035 Target device error
The SDK software to be installed does not
support the target device.

ERR-036

Error from the Activation or Component
Server

• The dada transmitted by RIM is
wrong.

Try to operate again.

If the same error occurs, ask your
supervisor.

ERR-037
Server internal process error from the
Activation or Component Server

Wait until the operation of the Activation or
Component Server is recovered.

ERR-038 Error from the Activation Server
The character number of the product key is
not correct. Enter a correct product key
with RIM.
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Error Code Descriptions Solutions

ERR-039

Error from the Activation Server or
error in RIM

• Other product key has been
registered for the target device on
the Activation Server. Previous
license update operation may fail.

• Use the product key which was used
in the previous operation, and then try
to update license again.

• Check the Operation UI Server to
confirm the product key which has
been used for the target device.

ERR-041

ERR-042

Server internal process error from the
Activation Server

Check the Activation Server condition.

RTY-005

Error from the Activation Server
Wait until the operation of the Activation
Server has recovered.

Error between getting a license and
installing on a device

• Use the product key which has been
used in the previous operation, and
then try to update the license again.

• Check the Operation UI Server to
confirm the product key which has
been used for the target device.

Server internal process error from the
Activation Server

Check the Activation Server condition.

RTY-011

Error from the Activation Server

• The dada transmitted by RIM is
wrong.

Try to operate again.

If the same error occurs, ask your
supervisor.

RTY-015
Server internal process error from the
Activation Server

Wait until the operation of the Activation
Server is recovered.

SRV-006

SRV-011

SRV-013

• Error at getting product key
information

• Error at downloading updated
software

Check the Activation or Component Server
condition. This is an internal error during
server processing.

SRV-021

Error at Product key entry

• Entered product key is invalided
by the Activation Server.

Check the entered product key status by
referring to the Operation UI Server.

SRV-022 Error at product key entry
The character number of the product key is
not correct. Enter a correct product key
with RIM.
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Error Code Descriptions Solutions

SRV-023

Error at product key entry

• The dada transmitted by RIM is
wrong.

Try to operate again.

If the same error occurs, ask your
supervisor.

SRV-024 Error at product key entry
Server internal process error of the
Activation Server. Wait until the operation
of the Activation Server is recovered.

SRV-025

Error at product key entry

• Entered product key is not issued
by the Activation Server.

Check the product key, and then re-enter
the product key with RIM.

SRV-026

Error at product key entry

• Entered product key is invalided
by the Activation Server.

• Check the entered product key status
by referring to the Operation UI
Server.

• Use another product key.

Detailed Device Error Number List

Error Number Descriptions Solutions

C05
Target device can not accept SDK
application and SDK/Java platform
package.

Error at Installation

• If the software to be operated is
installed in the target device, uninstall
it from the WIM or operation panel of
the target device.

• Check if the installed SD card in the
target device is correct or the installed
SD card is not write-protected.

Error at Offline Installation

• Check if the Java VM in the target
device is the version supported by
eDC-i1.2.

C13

• License file is expired.

• Clock timer in the target device is
not correct.

Check if the clock timer in the target device
is correct.

8. Troubleshooting

138

8



Error Number Descriptions Solutions

C16

C17

Writing some registries to the target
device fails.

• Reboot the target device, and then try
to operate again.

• If the software to be operated is
installed in the target device, uninstall
it from the WIM or operation panel of
the target device.

C19 Shortage of free space in SD card

• Reboot the target device, and then try
to operate again.

• If the software to be operated is
installed in the target device, uninstall
it from the WIM or operation panel of
the target device.

• Make free space in SD card
manually.

C27
Target device does not accept a
request from RIM because other
operation is still processing.

• Wait until the other operation of the
target device is completed.

• Check that the SP or UP mode is not
activated in the target device.

C35 Heap/Stack size is not correct.

• Configure the settings of Heap/Stack
size in the target machine.

• Enter correct values in the Heap/
Stack size setting if something other
than the correct value is entered.

• Enter correct values in the Heap/
Stack size setting if the entered values
are out of the setting range for the
target device.
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